# Table of Contents

Welcome to the Vehicle Spy Quick Start Guide ......................... 2

Vehicle Spy Overview .................................................................. 3

Minimum PC Hardware Requirements ........................................ 5

Vehicle Network Interface Hardware ........................................... 5

Using Your Hardware for the First Time ..................................... 8
  Installing the Software ............................................................. 8
  Adding Your License File .......................................................... 9
  Connecting Your Hardware ...................................................... 10

Getting Comfortable with the User Interface ........................... 14
  Views and Tabs in the User Interface ....................................... 17
    Tearing tabs ........................................................................... 17
    Replacing torn tabs ............................................................... 17
  Vehicle Spy “Views” ............................................................... 19
    Popular Views in Vehicle Spy ................................................ 19

Application Examples ................................................................. 28

Viewing the Data You Want........................................................ 30
  Part 1 - Log On and Load Up ................................................. 30
  Part 2 - Monitor Message Traffic ........................................... 32
  Part 3 - Examine Messages .................................................... 34
  Part 4 - Your Message Specification in Action ......................... 36
  Part 5 - Show Only “Module Message” .................................... 37
  Part 6 - Fast Filtering with column headers in the Messages View .................................................................. 40
  Part 7 - Message Timestamps and Pausing ............................ 42
  Part 8 - Saving Your Messages View Buffer ......................... 44
  Part 9 - Clearing the Messages View Buffer .......................... 46

Summary .................................................................................. 47
Appendix B: Requesting and Saving DTC Data.........................100
  Overview.............................................................................100
  Part 1 - Creating a Diagnostic Job Service .........................101
  Part 2 - Function block to Request and Save Data................102
  Part 3 - Making a Graphical Panel.....................................104
  Part 4 - Finding and Viewing the Data................................105
  Summary .............................................................................105

Appendix C: GMLAN Diagnostics ...........................................106
  Overview.............................................................................106
  Part 1 - Read DID Setup..................................................107
  Part 2 - Write DID Setup..................................................108
  Part 3 - Writing the Read DID ..........................................109
  Part 4 - Requesting PIDs from a Dynamic DPID.................110
  Part 5 - Requesting the Dynamic DPID.............................111
  Conclusion ..........................................................................112

Appendix D: ECU Flashing with Manufacturer Software......114
  Overview.............................................................................114
  RP1210 Support ..................................................................114
  Ford’s DET and the DLL Switcher ......................................114
    Step 1 – Locating the DLL Switch Program ......................114
    Step 2 – Using the DLL Switch Program .........................115
    Step 3 – Configuring Ford DET Software .......................115
    Step 4 – Reverting to the Old DLLs ...............................116

Appendix E: GM’s DPS Programming Automation ...............118
  Overview of GM DPS with Vehicle Spy 3 ..........................118
  Part 1 - Creating a DPS Diagnostic Job Service .................119
  Part 2 - Function Block to Launch Programming Services ......122
  Part 3 - Making a Graphical Panel....................................124
  Part 4 - Using What You Have Created .............................126
Welcome to the Vehicle Spy Quick Start Guide

This document was created to help Vehicle Spy users at every level of experience.

Whether you're a new or prospective user, or a seasoned user, these pages give a short summary of Vehicle Spy and its many possible applications. You can also quickly find information about specifications and hardware requirements.

Several Application Examples were included to help make learning the basics of Vehicle Spy quick and easy. Complete these exercises and you will have a solid foundation as you begin to work with Vehicle Spy.

If you need information about other products, visit the Vehicle Network Interface Hardware Section. This section includes information about hardware available through Intrepid Control Systems.
Vehicle Spy Overview

The Engineering Tool for Vehicle Networks

Vehicle Spy is a world class engineering tool for designing, testing, and analyzing networked vehicles of today and tomorrow.

Electronics in the vehicle have grown to an unprecedented level of complexity, from a handful of computers to literally dozens of computers situated in an in-vehicle computer network.

Complexity is further increased by the inclusion of multiple networks such as main networks, sub-networks, and multimedia networks, linked together by gateways. This newfound complexity makes development and verification of vehicle electronics systems a difficult challenge.

Vehicle Spy tackles this challenge head on with a focus on ease-of-use and user productivity. Vehicle Spy software contains many tools to help users access information quickly.

Key Uses of Vehicle Spy

- Use it as a bus analyzer that allows monitoring on network and message transmission.
- Can be used as a “data logger” or “flight recorder”, automatically capturing bus events and store trace files.
- Simultaneous operations on multiple networks. Each network may have a different protocol.
- Simulate nodes, gateways, or even entire vehicles.
- Your application here – Vehicle Spy has an entire spectrum of features that can accomplish your goals.

Vehicle Spy provides simultaneous, multi-protocol software support for many networks, including:

- DW CAN
- SW CAN
- LSFT CAN
- Ford SCP
- Ford UBP
- GM CGI
- K-Line
- GMLAN
- ISO9141
- J1708
- J1850 PWM
- J1850 VPW GM
- J1850 VPW Chrysler
- J1857
- J1939
- Keyword 2000
- LIN
- UART
**Minimum PC Hardware Requirements**

**Minimum Requirements**
- Windows 2000, XP or Vista with latest service packs
- 256 MB System RAM
- Intel Celeron 1 GHz
- 1024x768 Screen Resolution
- neoVI Blue, neoVI Red, neoVI Fire, neoVI PRO, or ValueCAN3 device
- One USB Port

**Recommended for Best Performance**
- Windows XP or Vista with latest service packs
- 512 MB system RAM
- 2.1 GHz or compatible
- 1280x1024 or better screen resolution
- neoVI Blue, neoVI Red, neoVI Fire, neoVI PRO, or ValueCAN3 device
- One USB Port

**Optional Hardware Support**
- Audio Card
- GPS (Global Positioning System) Unit with NMEA RS232 Interface
- Analog Data Acquisition Card (DAQ)
- PC Joystick

**Vehicle Network Interface Hardware**

Vehicle Spy supports a number of hardware interfaces for vehicle networks designed and manufactured by Intrepid Control Systems, Inc. Each has a high level of integration with Vehicle Spy.

neoVI Fire Vehicle Interface

neoVI Red and Red Limited Vehicle Interfaces
Recommended for: CAN and LIN networks.

neoVI Blue Vehicle Interface
Recommended for: Legacy busses such as J1850 VPW and PWM, GM Class 2, ISO9141, Keyword 2000, Ford SCP, OBD-II, J1587, J1708. Also has CAN and LIN.

neoVI PRO Vehicle Interface

ValueCAN3 and ValueCAN3 Limited Vehicle Interfaces
Recommended for: CAN networks.
Using Your Hardware for the First Time

When you first receive your hardware and software, you should have the following:

- A neoVI or ValueCAN Network Interface
- Software CD
- USB Cable (for ValueCANs, this is built into the device)

Installing the Software

**NOTE:** Install the software first! Even if you did not purchase software, this installation installs the driver files, API interfaces, RP1210 and J2534 drivers.

**NOTE:** If you are going to use Vehicle Spy and downloaded the software, make sure to download or get a copy of your license file. Contact Intrepid Control Systems if you cannot find your license file.

1. Start by inserting the CD. The CD should show this screen.
If this screen does not appear automatically, go to Start → Run, click on Browse… Then browse to the CD Drive and double-click on icsSetup.exe.

If you’ve downloaded the software from our web site, then run the vspy3_install.exe file you downloaded.

2. Click on Vehicle Spy 3 and follow the on-screen instructions. This will take a few minutes, since there are several drivers installed with the software.

3. Once the install program prompts you that Vehicle Spy 3 Software is installed, click on Finish.

4. With the install done, click on Exit for the first screen. No other installations are needed from this screen.

5. Double click on the orange Vehicle Spy 3 Icon to start Vehicle Spy.

### Adding Your License File

1. If this is a brand new install of Vehicle Spy, the application will ask for a license key when first started. The screen will look like the one pictured below.

   ![License File](image)

   ![Found New Hardware](image)

   a. Click on the “Add License File…” button highlighted in green.

   b. If you received a CD with your hardware, your license file will be located on the CD you received. If you downloaded the software, the license file may be given to you or downloaded from the same location. Contact Intrepid Control Systems if you have trouble locating your license file.

   c. Point the file open dialog to the license file found in the root directory of the CD (The extension is *.LIC).

2. If this install is an upgrade from a pre-existing install, open Vehicle Spy 3 and click on Tools → Options… and click on the “License” Tab. Click on the “Add License File…” button. Point the file open dialog to the license found in the root directory of the CD (The extension is *.LIC).

### Connecting Your Hardware

#### NOTE ABOUT POWERING YOUR HARDWARE:

If you are using a neoVI it requires power from a vehicle’s network connector using the cable included with the neoVI, or from an external power supply connected to the power pins on the device. The USB connector does not provide sufficient current to power the neoVI.

If you have a ValueCAN, all ValueCAN models power from the USB port and no extra power source is needed. Optionally, you can power the ValueCAN from the DB9 connector. If power is supplied to these pins on the DB9 connector, the ValueCAN will automatically switch to this power mode and isolate the PC from the ValueCAN ensuring complete protection to your laptop.

1. When you connect USB to the neoVI or ValueCAN to the PC, the hardware should install itself. You should see several balloons in your Windows Task Bar as the hardware installs. Once it finishes, it will say your device is installed and ready for use.
2. Run Vehicle Spy 3 by double-clicking on the orange icon on your desktop. When it starts, you should see a picture of your neoVI or ValueCAN device in the bottom part of the Logon screen, and your hardware should be listed below the Configure button:

   ![Device List](image1)

Click on the [+] sign next to the device’s name, and the available channels and baud rates will display.

3. The device has its own default settings for baud rates, but your networks may work at different baud rates. Before proceeding, make sure you know your network baud rates.

4. To configure baud rates, click on the Configure button above your device’s listing. You will get a display like this:

   ![Configure Baud Rates](image2)

5. Change baud rates by double-clicking on the Baud Rate selection and choosing the baud rate you need. Click on the X in the upper right corner of the window to close the setup.

   NOTE: If you have a set of baud rates you will always use, click on the Make Networks Default button. This will save the current baud rates as defaults in Vehicle Spy, and use them automatically in the future, even with different neoVI devices.

6. Connect your device to an active network, then click on the Start button. You should see the Messages View with message traffic displayed like this:

   ![Message View](image3)

You are now successfully connected using your neoVI or ValueCAN.

7. If you have any baud rate conflicts between your hardware device and Vehicle Spy, the Networks View will display with red highlights where there are conflicts. To resolve these, click on the Apply to Hardware button to apply the settings in Vehicle Spy to the hardware. Also you can press the Apply to VS3 button to upload the configuration from the device to Vehicle Spy.

   ![Networks View](image4)

Then click the Messages tab, and you should now see traffic like in Step 6.
Getting Comfortable with the User Interface

Before reviewing the Application Examples, it is important to get familiar with the Vehicle Spy interface. It is designed to be intuitive and easy to navigate.

The Menu Bar: Across the top of the Vehicle Spy interface is a standard format menu bar. The Menu Bar contains menus such as File, Setup, Vehicle Networks, Measurement, Embedded Tools, Scripting and Automation, Run, Tools, and Help. From the Menu Bar it is possible to access all the features of Vehicle Spy. The Menu bar also contains the Data button and the Help button. These buttons allow for fast access to recorded data files and help documentation. As you work with Vehicle Spy, you will also see a set of tabs build up in the Menu Bar. These tabs are used to control the views displayed in the Main Workspace. When you choose a view through the Menu Bar or the View icon, a tab for that view will automatically appear in the Menu Bar. (Notice the Messages view tab is visible.) You can remove the tab by clicking the "x" in the tab itself. Customizable tab sets allows each user to create an interface that best suits their individual needs. The
desktop icon \(\text{Desktop Icon} (\text{icon})\) gives the user a way to create more than one workspace arrangement and to save those arrangements for use with other Vehicle Spy setup files.

2 The Main Workspace Panel: The majority of the Vehicle Spy user interface is devoted to the Main Workspace Panel. It is where the Logon Screen appears when you start up Vehicle Spy and where most activity occurs. The view shown in the Main Workspace changes based on the view selected. Different views are selected by selecting the group (Vehicle Networks, Measurement, Embedded Tools, or Scripting and Automation) from the Menu Bar or by clicking the View icon (\(\text{View Icon} (\text{icon})\)), also in the Menu Bar, and choosing the desired view from the drop down list.

3 & 4 Docking Windows: Often times, it is necessary to see multiple views simultaneously. To accommodate this, Vehicle Spy provides Docking Windows. These panels are docked along the bottom and the right side of the Vehicle Spy interface. They function in the same way as the Main Workspace panel. Each Docking Window has a customizable set of tabs and a View icon (\(\text{View Icon} (\text{icon})\)) to make view selections.

5 The Filter Panel: On the left side of the Messages View is the Filter Panel. This panel is used to activate the many filtering capabilities found in Vehicle Spy. For example, you can select to view only HS CAN traffic by selecting the check box next to HS CAN in this panel.

6 The Quick Setup Buttons: When jumping from project to project it may be necessary to change network and hardware settings. The Quick Setup buttons are a quick link to those common configuration or database views in Vehicle Spy.

Quick Buttons: (from left to right) Networks Spreadsheet, Database Platforms, ECU’s, and Setup Data Cache Disk Streaming

All of the panels in the Vehicle Spy Interface can be opened, closed, moved, resized, and even torn from the main window based on user preference. To resize, move the mouse over the

dark lines between the panels until the mouse cursor turns into a pair of arrows. Just click, drag, and release when panel is the desired size.

*Note the \(\text{Drag Indicator} (\text{icon})\) indicator in the figure above.
Views and Tabs in the User Interface

To help increase productivity, Vehicle Spy users have the ability to “tear” tabs from the main workspace to arrange views that make the most sense. With this feature, views can “float” and be resized. Users can position views precisely where they will be the most useful.

Tearing tabs

Tabs in Vehicle Spy can be “torn off” or removed from the main window. This comes in handy when needing to see a number of different views at the same time or when a particular arrangement of views on the screen would be helpful. Tabs are removed from the main window by clicking on the tab or view and dragging the view away.

Replacing torn tabs

Tabs that have been removed can easily be returned to their previous positions or placed in other views. This is done by clicking and dragging on the view's title bar and moving it towards the desired location. When the view gets close to a possible docking location, a dock option will appear. Moving the mouse over the dock option will snap the view to the new location. The highlighted area is where the view will go if the mouse button is released. To prevent the view from snapping to default docking locations, hold the Control button on the keyboard while dragging.

Using the Docking Icons that appear while tearing and dragging.
Vehicle Spy “Views”

Each function of Vehicle Spy is organized into a unique window that can be resized, controlled separately and combined with other displays at the same time. These are called “Views.” Here is a description of major views available in Vehicle Spy.

Popular Views in Vehicle Spy

Vehicle Spy allows simultaneous monitoring and transmission on multiple vehicle networks. These networks can have different vehicle network protocols. The configurable Views allow for quick maneuvering between screens, multiple desktops, and docking multiple views on a single desktop. It is possible to save and recall Vehicle Spy setup files that contain all docking and tabbed layouts. The most popular views in Vehicle Spy are:

- **Logon View**
  - Manages multiple users and projects
  - Keeps track of your last setup files
  - Manages data directories

- **Databases**
  - Load an external database that can define the messages received and transmitted on the vehicle network
  - Databases allow automatic description and display of messages and signals
  - Allows quick entry into the Message Editor
  - DBC and UEF file formats for import and export support
  - Each network can have a separate database, and/or multiple databases for each network

- **Messages View**
  - Displays message text descriptions
  - Displays all signals contained in a message such as RPM, Pedal Position, Vehicle Speed, etc.
  - Include and exclude filters based on Network, Node, Message, Data Type, and Custom Filters
  - Displays multiple network data in the same monitor
  - Pause and review history
  - Absolute and relative time display
  - Storage and Review of Data Files in an Excel compatible format which includes message descriptions and signals
  - Post acquisition filtering and analysis
  - Hexadecimal, Decimal, Binary, and ASCII data displays
  - Color Filters based on Message, Network, or Node
  - Buffer History is limited only by system memory – allows history lengths of greater than a million messages
  - Custom fonts and colors
  - Bus load display
  - Activity Highlighting – Portions of messages that are changing are highlighted depending on periodic or event-based updates.
  - Sort the monitor based on any message part, even with wildcards
  - Copy Messages to Message Editor quickly through right-click menu
• Edit messages using spreadsheet format and/or easy-to-use dialog
• Received Messages and Transmit Messages organized into separate tables
• Online interactive editing (you don't have to stop Vehicle Spy or go "offline")
• Specify Message with byte or bit resolution for entire message
• Database button allows you to copy and paste messages with signals from the loaded databases to the Transmit or Receive Tables for editing.
• Calculate a binary, state-encoded, text, or analog signal from a message with an arbitrary equation.
• Custom binary and analog formats including binary, hex, engineering, and scientific notation
• Link to a Transmit Message on any network allows auto response or transmit on change functionality
• Enables you to extend the Message filtering to include the message data bytes so that separate messages with the same ID but different data bytes can be interpreted separately.
• Expected Length input verifies a message's length
• Specify based on message properties such as errors or bus events
• Selectable color specification per message
• Cut, copy, paste, and sort messages and signals

• Messages defined in Message Editor View on the Transmit Table are automatically listed in the Transmit Panel
• Transmit Message data can be calculated from messages received or other data
• Periodic message transmission
• Manual transmit button included as part of the panel
• At Start allows transmission of message once when hardware is started
• Calculated signal type allows waveform generation (sine, ramp, etc.) and custom equations for signal generation
• Custom List signal type allows sending values from a list or Excel spreadsheet
• + and – buttons enable you to increment or decrement signal values based on a configurable setpoint.

• Supports any number of Nodes
• Nodes can come from different networks
• Selectable color specification per node
• Nodes Stats for all networks including: message count, message rate, message rate max, bus utilization, and bus utilization max.
VehicleScape

- Simplifies gathering data from various bus resources, such as DTCs, database signals, ECUs CCP / XCP and more
- Log data from various sources to a log data file
- Global list of possible signals include all database signals, signals from diagnostic information, CCP / XCP parameters and all analog or digital IO available

Signal Plot

- Allows live plotting of data (ie: strip chart/oscilloscope
- Cut and Paste displays to Windows applications
- “Spinner” feature shows data update even if value has not changed

Signal List

- Provides values of signal in a spreadsheet format
- “Spinner” feature shows data update even if value has not changed

Logging

- Saves data from signals within messages without message data
- Logging may be started and stopped manually or based on an expression
- Log rate can be set independent of bus update rate

Graphical Panels

- Build your own custom application with panels that have controls and indicators
- Controls and indicators include the following: Chart, Transmit Button, Function Block Button, On/Off Button, Knob, Meter, LED/Light, Text Display, Text Entry, Numeric Entry, Graphical Display, Dropdown List, Bar Graph, Grid, Action Button, and Scrolling Monitor
- Charts X vs. Y and Y vs. T
- Dropdown control for State Encoded parameters such as PRNDL or Power Mode
- Action Button allows printing of panel, switching panels, and access to the user's data directory
- Graphical display allows colored lines and custom graphics, such as logos, on the panel
- Each user interface item has many properties allowing customization
- Visual Basic style property editor
Data Analysis

- Allows graphing and analysis of saved data files
- Overlay or stack plots of signals
- Graphs zoom/scroll
- Cursor features allow measurements between two cursors or measurements at a single cursor
- Graphs can be printed, saved or cut and pasted into an Office document
- X/Y Plotting, Histograms, Y/T plotting
- Calculated signals based on other signals and algebraic equations
- View data graphically and in an Excel like table at the same time
- Cursors allow quick viewing of values and information about data between the cursors (min, max, std dev, mean, etc.)

Function Blocks

- Playback Block allows replay of captured network traffic back with optional filter
- Script Block allows custom script which has script commands: Jump to step, Transmit message, Wait for a specific amount of time, Wait for a specific equation to be true, Trigger/Start/Stop/Save another function block, Set an incoming message to value or equation, Reset a message’s stats, Stop script, Show a graphical panel, and Jump to a step if an equation is true.
- Capture allows capturing a network buffer with pre/post triggering based on an arbitrary equation
- Automatically save network traffic with unique file naming
- Actuate a digital output based on an event
- Transmit a group of messages with a programmable inter-message delay and offset
- Start, Stop, and Trigger the Function Block based on equations, Java, or other function blocks
- Create as many function blocks as you require
Application Examples

There are many ways to use Vehicle Spy, and it can provide a solution for virtually every application. To help you tackle the most common applications, we’ve put together Application Examples.

If your application is not listed here, you can check the Examples call Intrepid Control Systems’ technical support line. We maintain examples of most applications which you can use with little modification.
Viewing the Data You Want

This first application, Viewing Network Data, is a great way to start getting comfortable with Vehicle Spy. As you work through the following exercises you will learn how to logon, view message traffic, and filter messages, along with many other important skills.

Part 1 - Log On and Load Up

1. Start Vehicle Spy: After you have fully installed Vehicle Spy, its icon should appear on your Desktop. Double click the orange icon to run Vehicle Spy. By default, Vehicle Spy will open with the Logon Screen displayed below. If Vehicle Spy was already running or you skipped over the Logon screen, you can reopen it by clicking “File” in the Menu Bar and then selecting “Logon”.

Logging on and loading a file
2. Select your Logon Name from the Logon Name List:
Vehicle Spy uses your Logon name to set up a default location for your data files and setup files. If you have logged into Vehicle Spy before, simply select your name from the dropdown list. If you are a new user, you must create a new Logon Name. Simply click the "New" button next to the Logon Name field. The "Create a User" window will open. Enter your name or other label and click "OK".

3. Load the Vehicle Spy Setup File: To start this exercise, we need to load a Vehicle Spy setup file called “Tutorial 1 - Basics of Vehicle Spy”. This file contains all the data we need to complete the rest of this Application Example. To load this setup file, select the "Examples" tab in the Logon view. Then select the file from the list. After selecting the file, click "Open". This will load the setup file. (To double check you have loaded the correct file, verify that the name above the Menu Bar says, "Tutorial 1 - Basics of Vehicle Spy".)

Part 2 - Monitor Message Traffic

1. Select Messages View: Using the Menu Bar, select Vehicle Networks and then Messages. The Messages view opens in the Main Workspace. After you choose this view once, a tab for Messages appears in the Menu Bar. Vehicle Spy always creates a tab based on your view selection. Vehicle Spy strives to make workflow as efficient as possible by creating a personalized interface for each user.

2. Start Vehicle Spy: Click the start button located in the upper left corner of the interface. You should see changing data appear in the Main Workspace. See 1.

Messages View – To scroll or not to scroll?

3. Take A Look at the Message Traffic: The data you see in the display has been previously recorded. We are simply replaying it for the purposes of this exercise. We refer to this as "Simulation Mode". This is indicated by blue text adjacent to the start button. Simulation mode is a very useful option, especially for training, because it allows you to explore features and experiment without having network hardware or being connected to a vehicle. Messages View has two options for viewing data: Scrolling...
and Static views. You can alternate between these views by clicking the "Scrolling" button in the upper left of the Messages panel.

Pressing the "Scrolling" button allows you to view the stream of messages flying by. You can click on the "Pause" button along the top of this panel to stop the scrolling without stopping Vehicle Spy. A bar appears to the right that allows you to scroll through the messages.

Press "Scrolling" again to see a static view of the messages. All messages that have been detected at least once are listed. Messages that have recently changed are highlighted gray. Messages that were present on the bus at least once but have not changed since are first highlighted in blue and then gradually fade to white. See [2].

4. **Stop Vehicle Spy:** After you are comfortable with how data appears in Messages View, click the Start button again to stop Vehicle Spy.

**Note:** It is important to point out that you do not need to "stop" or "go off-line" to edit in Vehicle Spy. You did it in the step above as an exercise. In fact, you can do most functions while connected to a vehicle bus, in "live" mode.

---

### Part 3 - Examine Messages

Let's suppose you were interested in looking at one specific message in your message traffic. Messages View can be set up to display precisely what you wish to see. It is completely customizable. In the next couple steps we will set up a basic message specification, a good place to start as we begin to explore Vehicle Spy’s filtering capabilities.

1. **Switch to Messages Editor View:** Select Messages Editor view by clicking on Vehicle Networks and then Messages Editor. Messages Editor opens on top of Messages view in the Main Workspace. (Notice that tabs for both views are visible at the top of the Main Workspace; this makes it easy to switch back and forth between the two.

2. **Create A New Message Specification:** For this exercise, we want to specify a received High Speed CAN message. Make sure that "HS CAN" is selected from the Network dropdown and the Receive button is depressed. Both controls are found at the top of the Message Editor panel.

   ![Building a Message Specification](image-url)
Click the [+] button at the top of the panel to create a new message specification. (Specifications can be removed just as easily – with Vehicle Spy stopped, simply click on the row you wish to remove and then click [-].) An empty row appears in the upper spreadsheet portion of the panel and the Setup dialog opens in the lower portion. We will define our new specification using the Setup dialog. See 1 & 2.

3. Enter "Module Message" in the Description Field: Next we want to attach a description to our message. We will call it "Module Message". Click inside the Description field in the Setup dialog and type "Module Message". See 3.

4. Enter and Arbitration ID of 110: Now enter an arbitration ID of 110 into the Arb ID field. This attaches our "Module Message" description to messages with Arb ID 110 4.

5. Give the Message a Color: It is often beneficial to add a color to a message. With so many messages flying by, custom colors make instant visual identification possible. Click on the small arrow at the right of the Color field. Select the color of your choice from the drop down that opens 5.

6. Examine Your Completed Message: That is all we need to set up for this exercise. Take a look at your work in the grid portion of the Messages Editor panel. All the specifications you entered in the Setup dialog are automatically added to the spreadsheet. Make sure your message looks exactly like the one above.

Note: Depending on your preference, message information such as description or arbitration ID can be entered directly into the grid or in the Setup dialog. The changes made in one place will also occur in the other.

Part 4 - Your Message Specification in Action

Now that we have everything all setup, let's see what we have done by switching to Messages view.

1. Open Messages view: Use your custom tab set at the top of the Main Workspace to switch back to Messages view.

First, make sure Vehicle Spy is running. (Click the start button if necessary.)

Press the "Scrolling" button. Notice our "Module Message" description is present, attached to HS CAN messages with Arb ID 110.

Now turn scrolling off. Our "Module Message" is there as well, displayed in the custom color you selected.

Is data in your message changing? Remember you can spot this easily because of the gray activity highlighting.
Part 5 - Show Only "Module Message"

A complete message specification is the basic building block of a custom filter. In this part of the Application Example, you will create your own custom filter.

1. Open the Messages View: Select the Messages tab. When the panel opens, notice the Filter Bar that appears automatically on the left side. This is a convenient way to turn on and off all sorts of filters you may use in your applications.

Notice the "Custom 1" heading in the list. Click on the small blank box into the right of the heading. This opens up the "Filter Setup" dialog which is where you define your filter.

2. Create Your Custom Filter: The Filter Setup dialog makes it easy to quickly set up a filter. At the left side of the dialog is a list of message sources. This enables you to access messages defined in the Message Editor, entered in your database, etc. Make sure that the Rx Messages option is selected. Notice that "Module Message" appears in the list under High Speed CAN. Vehicle Spy automatically places every message you define in its appropriate place to make workflow as efficient as possible. Highlight "Module Message" and then click the "Add to Included List". This adds "Module Message" to your filter.

3. Name Your Filter: When working with multiple filters, specifying names can help to keep things organized. Double click inside the "Name of Filter" field and name this filter "First Filter". When you are finished, click the "OK" button to return to the Messages view.

4. Activate Your Filter: Now take a close look at the Filter bar. The Custom 1 heading has been replaced by "First Filter". Make sure that Vehicle Spy is started and then click inside the first column to the right of your filter name. A green check mark appears in the column, the "First Filter" text turns green, and your message traffic changes dramatically. Instead of seeing all messages on the bus, you see only your Module Message.
5. **Adding Extra Custom Filters**: If extra custom filters are necessary, click the “Add” button above the filter bar to create extra custom filters. Extra custom filters can be removed by right clicking on the filter and selecting “Remove Message Filter”.

**A Note About Filtering**: When using filters in Vehicle Spy, you can exclude messages as well as include them. In order for this to work properly though, something must always be included before you can exclude. Vehicle Spy looks for included messages first and then excludes from that list.

For example, let's say we want to remove our Module Message from the message traffic. First place a green checkmark next to the Network heading under Data Types in the Filter Bar. The Network filter simply includes all network traffic. Next, click in the second column to the right of the "First Filter" heading. An "X" fills the column, "First Filter" text is now red, and Module Message is excluded from the message traffic.

Feel free to experiment with the Filter bar for a little while. Include all network traffic and then exclude all HS CAN messages. Try to include all HS CAN messages and exclude your "Module Message". The Filter panel gives you endless ways to customize your view of the data.

---

**Part 6 - Fast Filtering with column headers in the Messages View**

Besides setting up custom filters, there are other ways to filter in Vehicle Spy. Take a close look at the column headings in Messages view. Click on the Description heading and a symbol for alphabetical order appears adjacent to the text. The column is reorganized from A to Z. Click on the same heading again and the order is reversed, from Z to A. When monitoring many messages, this provides an easy way to move quickly back and forth without excessive use of scroll bars. Clicking on another heading will move the focus of the sort to a new column.

![Alphabetizing Columns and Column Filters](image)

Just below the heading in each column is an empty space reserved for column filters. Double click in the space below the Description heading. A small arrow appears to the right, indicating a dropdown. Click on the arrow. In the dropdown, you will see a list of all message descriptions that have appeared in your Messages view. Click on one of the listed descriptions and press enter. Now the message description is visible in the space under the column heading. Only messages with that description are shown. This filtering technique applies to the other columns such as Arbitration ID as well.
Now, imagine for a moment that you are working with hundreds of messages. The specific message you are looking for has an arbitration ID that has a 6 in it, but you have forgotten the actual number. Simply type “6” in the blank field beneath the Arb ID column heading and hit enter. Only messages with an Arb ID that includes a 6 are visible such as 640, 126, and 260. For another example, imagine that you know your desired arbitration ID ends in a 3. Simply enter in “??3” and Vehicle Spy shows you all Arb IDs ending with the number 3. (123, 333, 643, etc.) To include more than one message in your filter, enter both in separated by a comma (??6,110,?33 Note: no spaces after commas!). Also you can filter a range of ID’s by using a “-“. For example, to filter between 100 and 1FF you can type in “100-1FF”. These column filters work on other columns as well. If you are working with a database and all of your messages and signals are defined, you can enter “eng” or “odo” in the blank space below the description field. Only messages and signals with those letters in their descriptions, those pertaining to engine and odometer, will remain.

To remove a column filter, simply click and highlight it, then press delete.

Column filters provide a fast and efficient way to sort through hundreds of messages without setting up a custom filter.

Part 7 - Message Timestamps and Pausing

When you have finished experimenting with the filter panel, please return to where we left off by including only our “Module Message”. In this exercise we will examine a couple other important features found in Messages view.

1. Relative and Absolute Timing: Please click the Scroll button in Messages view if you are not already in this mode. You may have noticed the Time column in the display. Each message is recorded with its own unique time stamp. By default, Messages view displays the Relative time for each message. Relative time is the time difference between consecutive messages. Click the button at the top of Messages view to toggle to Absolute Time. This is the time of the arrival of the message since you started Vehicle Spy.
2. **Pausing**: When using Messages view, the ability to pause is very important. With scrolling on, click the Pause button located just to the right of the button. The scrolling stops and scroll bars appear on the right side of the panel. Click and drag the scroll bar or use the page up/down keys to step through previous message traffic. The Pause button functions in the same way in both scrolling and static modes.

---

**Part 8 - Saving Your Messages View Buffer**

You may wish to save the data you collect for later analysis.

1. **Save Your Collected Buffer to Disk**: Click the Save button found at the top of the Messages view. The "Save Monitor Data" dialog will open and fill the main workspace. You can enter a name for your data file or you can use the default name which includes time and date.

   For this exercise, please call the file "<Your Name> Data File". Directly below the File Name field, there is an additional blank field. You may use this area to enter any notes that you wish to save along with the data. When you are finished, click "Save" and your data will be stored.

2. **Open Your Data File**: When you clicked "OK" in step 1, your data was automatically saved in your Data Directory.
This is basically a subdirectory named with your Logon name. It serves as the default location for all of your data and settings.

To access the file you just saved, click on the Data button located on the right side of the Menu Bar ①.

Your data file is shown in your data folder. Double click your data file ②. It will open in your default editor for CSV files. Excel, if installed, is usually the default editor. If you do not have Excel, it will likely open in Notepad. You can also open these files in Vehicle Spy itself for review and analysis purposes.

Part 9 - Clearing the Messages View Buffer

At some point, you may wish to clear all the data you have collected from Messages view.

1. **Select Messages:** Select Messages view from your custom tab set.

2. **Clear the Buffer:** Press the Erase button located in the upper right corner of Messages View ①.

3. **Observe that Messages View has been Cleared:** Notice that the message counter column starts over again at one.
Summary

Whew!! You made it through all of the basic features in Vehicle Spy. Just to recap, we covered the following subjects:

- Loading a setup file with the Logon dialog
- Viewing message traffic, both scrolling and static
- Specifying a message through the Messages Editor view
- Viewing messages in Messages view
- Setting up a custom filter
- Filtering using column filters
- Turning filters on/off and switching between include and exclude
- Absolute/Relative timestamps
- Pausing data
- Saving collected data to disk
- Clearing the Messages buffer

Transmitting Messages with Vehicle Spy

This Application Example will teach you multiple ways to transmit messages with Vehicle Spy. You will also gain experience with an important user interface feature – Docking Windows.
Part 1 - Load the Setup File

In this exercise, you will learn how to transmit messages on an in-vehicle network using Vehicle Spy.

1. **Return to the Vehicle Spy Logon screen**: You may do this in two different ways. First, if you already have Vehicle Spy open, make sure that it is stopped, and then click on "File" in the upper left of the Menu Bar. Select "Logon..." from the dropdown. If Vehicle Spy is not open, double click the icon on your desktop. Vehicle Spy automatically opens to the Logon screen.

2. **Load a Setup**: Click on the Examples tab in the Logon panel. Scroll through the list of titles until you find "Tutorial 2: Transmitting Messages". With the title highlighted, click open 1 & 2.

Part 2 - Entering a Transmit Message

In Viewing the Data You Want, you set up a message specification in the Messages Editor view. Now we will return to this view to set up a message to be transmitted by Vehicle Spy.

1. **Open the Messages Editor Panel**: Using your custom tab set at the top of the Main Workspace, open the Messages Editor view 1.

2. **Switch to the Transmit Messages Table**: Click on the "Transmit" button along the top of the Messages Editor panel. This switches to Transmit message setup. Next click the "+" button to add a new message 2 & 3.

3. **Define your Transmit Message**: After you click the "+", a Setup dialog opens. This is where you enter in your transmit message specifications such as description, Arb ID, and color. Create a message called "Our TX Message" for HS CAN. Give it an Arbitration ID of 500 and data bytes 11-22-33. (Begin entering the data bytes in column B1 in the spreadsheet or in field Byte 1 in the dialog.) We will take care of the other specifications later.
4. **Examine Your Completed Message:** Notice how all the information you added in the Setup dialog was automatically added to the spreadsheet view just above.

Part 3 - Utilizing Docking Windows

Back in the Vehicle Spy User Interface Introduction, you were introduced to Docking Windows docked at the bottom and the right of the user interface. In this exercise we will use one of these panels to view both the TX Panel and Messages View simultaneously.

1. **Open Messages View:** Select Messages from the Vehicle Networks dropdown in the Menu bar. Messages view opens in the main workspace.

2. **Set the Bottom Docking Window:** Click on the View icon at the lower left of the user interface. Select "Vehicle Networks" and then "Tx Panel" from the dropdown. The TX Panel opens in the Docking Window area at the bottom of the user interface while Messages view stays in place.

   Click and drag the border to resize a panel.
Part 4 - Manually Transmitting a Message

Now you should have Messages view open as well as the Transmit Panel. Take a close look at the TX Panel. "Our TX Message" is there already! Vehicle Spy again makes your life easier by eliminating redundant typing and copy/pasting. Now let's see how the TX Panel works.

1. **Start Vehicle Spy:** Make sure you see data flowing in Messages view.

2. **Click on the Manual TX Button:** To the right of "Our TX Message" description in the Transmit Panel is a small "Tx" box. Clicking this box transmits our message. Go ahead and give it a click.

If you are in Static mode in Messages view, "Our TX Message" should now appear in the list of messages. It will be highlighted initially to signify recent activity. If you do not transmit the message again soon, the highlighting will fade away. If you were in Scrolling Mode, you probably didn't see anything. By the time you clicked and then looked at Messages view, the message had already gone flying by. You can click the Pause button and scroll back through the messages until you find it. (Tx Messages are marked with a green LED icon for easy identification.) You can also just click TX again while paying closer attention. You should be able to spot in the traffic.

All TX Messages have a green LED symbol in the Tx column in Messages View. This signifies that the message is a transmit message.
Part 5 - Periodically Transmitting a Message

Often a message must be transmitted regularly. Rather than sitting around clicking "Tx" all day, Vehicle Spy enables you to specify when and how often a message will be transmitted.

1. **Set the Auto TX and the Period:** Look at the TX Panel again and make note of the Auto TX column and the Period column. Previously we left these blank, but now we will set them up. Double click in the blank in the Auto TX column that is adjacent to our message. From the dropdown that opens, select "Periodic". Next double click in the space directly to the right, the period column. A dropdown of common values appears. If you need a specific value not found in the dropdown, you can type it into the field directly. For this exercise, select 0.1 seconds from the dropdown. We have just told Vehicle Spy that we want "Our Tx Message" to transmit periodically every 0.1 seconds.

2. **Check Out Your Message Traffic:** After you have this all set up, look back at Messages view. If you are in Scrolling Mode, you should see a steady stream of TX messages flying by. If you are in Static Mode, "Our TX Message" should be highlighted and the message counter should be increasing rapidly. 
Part 6 - Automatically Responding to a Message

Besides manual and periodic transmission, Vehicle Spy is also capable of automatically responding to a message.

1. Set "Our TX Message" Back to Manual: To remove the 0.1 periodic transmission, simply set the period column back to "None".

2. Go to the Message Editor: Open the Message Editor using the tabs for your main workspace. Notice that a message called "Test Message" has already been set up in the Received table for use in this exercise.

3. Double Click the TX Msg Column for the Test Message:

Using the spreadsheet view, double click on the Tx Msg column. A dropdown of defined Tx messages opens. (In this case, there is just "Our Tx Message", but if more transmit messages were defined, they would also appear here.) Select "Our Tx Message" and press Enter. We have just told Vehicle Spy to automatically send out "Our TX Message" every time it receives "Test Message".

4. Take a Look at the Message Traffic: Observe that for every occurrence of Test Message, Vehicle Spy responds with a transmission of "Our Tx Message". (This will be easiest to view with Scrolling On but you may have to Pause.) Your Messages view should look similar to the one below.

5. Something Extra: For extra practice, you could set up a custom filter to include both "Test Message" and "Our TX Message". Or you could try to do it by using column filters.
Summary

By completing this Application Example, you have learned how to:
- Create a Transmit message
- Utilize Docking Windows
- Manually Transmit a Message
- Periodically Transmit a Message
- Automatically Respond to a Received Message

You are well on your way to becoming a Vehicle Spy expert!

Decoding Signals from Messages

Part 1 - Loading a Setup file

Many network messages contain information called signals. These signals fall into two categories, analog and digital. Digital information can be thought of as yes/no, on/off, or open/closed. Things such as lights on/off and door open/closed fall into this category. Analog information, on the other hand, is not limited to two simple states. It is variable. When you think of analog information, think of Vehicle Speed, Engine RPM, Coolant Temperature, or anything else with variable values.

In this Application Example, you will have the opportunity to extract or decode analog signals with Vehicle Spy. Decoding digital signals is done basically the same way, so this exercise applies to that as well.

First, Load the Setup file: As we have done in the other Application Examples, make sure Vehicle Spy is stopped and go back to the Logon screen. Next click the Example tab, and select the file for Tutorial 3 - "Decoding Signals from Messages".

Here we go!
Part 2 - Enter a Message

1. **Create a HS CAN Message**: Open up the Messages Editor view in the Main Workspace using your custom tab set. Define a new Receive message for HS CAN. With HS CAN selected, click the "+" button.

Using the Setup dialog, enter the following specifications:
- **Description**: Engine Parameters
- **Arbitration ID**: 110

2. **Add a Signal**: The lower portion of the Setup dialog contains a "Signals in Message" field. Click the "+" button next to this field to add a blank signal specification.

   Enter "Throttle Position" in the Description field.

3. **Change the Value Type to Analog**: Throttle position can have many possible values. It is variable and therefore analog rather than digital. Click the arrow in the Signal Type field. Select Analog from the dropdown.

4. **Enter a Format of "0.0"**: Click the arrow in the Value field. Select 0.0 from the dropdown.

5. **Enter Engineering Units of "%"**: Type "%" in the Units field. This will cause the throttle position values to be displayed with % as its engineering units.
Part 3 - Enter an Equation for an Analog Value

To indicate how the value is encoded in our Throttle Position signal, we need to enter an equation.

1. **Edit the Equation**: Click the “Edit” button to the right of the equation field. This will open the Value Decoding dialog.

2. **Enter the Raw Value**: By default the Raw Value Type is set to "Unsigned Integer". Next we need to tell Vehicle Spy which bytes in the message we want to decode. Click on the "Start Bit" tab and make sure the Bit Position is set to zero. Click on the "Length" tab and enter a length of 8 bits. This setup will set the first byte of the Vehicle Parameters message as the raw value of the Throttle Position signal. Leave the "Endian-ness" tab in its default setup.

3. **Enter a Linear Scaling Factor**: Make sure that the Scaling Type is set to "Linear mX+b. Enter a linear scaling factor of 0.3921568 in the Engineering Value field. This value will scale an 8 bit value to percent. \((0.3921568 = 100/255)\).

4. **Finish Your Equation**: Press "OK" to finish your equation. The Value Decoding dialog will close and you will return to the Messages Editor view. You should see the equation you entered in the lower portion of the panel.

**Note**: If we were decoding digital signals, the procedure would be very similar. You would simply select "Digital" for Value Type and then enter in a digital equation. For example, the digital equation "\((B1) \text{ and } 1) > 0\)" would be true if bit 1 of byte 1 was set. It would be false if it was not set.
Part 4 - Viewing Message Data

Now let's take a look at what we've done.

1. **Create a Filter for the Throttle Position Message:**
   Using skills from previous exercises, set up a custom filter that shows just the Engine Parameters message. In this example, this is not essential but if you were working with many messages, a filter such as this would be very helpful.

2. **View Message Traffic:** Switch to Messages view with Scroll Off. Notice the Engine Parameters message in the list in the custom color you specified.

3. **Expand Message to Show Signals:** To the left of the message description is a small "+". Click on this to expand the message. Now you can see the Throttle Position signal we defined within the Engine Parameters message. If we had defined more signals for this message, they would appear here as well. Click the "-" to see only the message again.

4. **Switch to Scrolling:** Switch the Messages view to Scrolling. Now is the time to turn on your filter. With the filter activated, you should see just the Message Parameters message. Press Pause. Note the "+" to the left of the message description just as in static view. Click on the "+" again to see the signal defined within the message.

*Note that Activity Highlighting is automatically applied to signals as well as messages. In case you have forgotten, back in Viewing the Data You Want, Part 2, we briefly covered this topic. Here are the basics of Activity Highlighting once more: All messages and signals that have been detected on the bus, even just once, are listed in Static View. (In Scrolling View, they are all recorded as well, but depending on your buffer size, they may or may not be present.) Messages and/or signals that have recently changed are highlighted gray. Messages and/or signals that were present on the bus at least once but have not changed since are highlighted blue and gradually fade.
Part 5 - Viewing Message Data Using the Signal View

Vehicle Spy includes tools for monitoring active signals. Signal List shows the most current value of signal data in a grid. Signal Plot displays a strip like plot of the signal data. The figure below shows both views open using multiple workspaces, Signal Plot at the top and Signal List at the bottom.

1. **Access Signal View:** The Signal Plot and Signal List can be found under Measurement in the Menu bar. Either view will allow you to create groups of signals called Signal Groups.

2. **Build a Signal Group:** To build a signal group, click on the "Select Signals..." button located on the Signal Plot or Signal List view. The Vehicle Spy Expression Builder opens. This is where signal selection occurs.

3. **Select Your Data Source:** Each group you define can contain multiple messages and signals. The group can also contain multiple properties and values of these messages and signals. Begin by selecting your data source. Choosing "Messages" reveals all received messages and signals we have defined in the Message Editor.

4. **Select Your Messages and Signals and Their Properties:** In the Properties window, highlight the property you wish to display. Next, in the Messages window, select the message or signal you wish to display. Last, click the Add New Signal button to add your selection to the Signal Group.

For this Example, graph the Present Toggle Property of your Engine Parameters message and the Value property of your Throttle Position signal.
5. **Give Your Signal Group A Name:** Click in the Signal Group Name field and type “My Signal Group”. This is an important step if you are working with multiple groups.

   Before you click OK to return to the Signal view, double check your setup in the window just below the Signal Group Name field. This window displays all data included in the group. The selected property of each is displayed in parentheses. The "+" and "-" symbols are used to add and remove items from the group. To remove an item, for example, just click to highlight and then press the "-" button.

---

**Part 6 - An Introduction to the Signal View Features**

The Signal Plot view and the Signal List view are powerful tools for viewing decoded signal values. They have too many features to discuss in detail in this exercise. Below, however, is a brief look at some of their capabilities.

1. **Select Signal Group to View:** The Signal Plot View and Signal List View allow you to view multiple Signal Groups simultaneously. The Signal Plot View shows the signals in a graphical way while the Signal List displays decoded signal values in a list format. You can select the signal group to display by using the dropdowns located above both the graph and the grid. The dropdown contains a list of all Signal Groups you have setup with the Expression Builder.

   With My Signal Group selected, you should see two Y-axis, each a different color and corresponding to a signal or message in the group. The x-axis represents time.
2. **Try Out Tools in the Toolbar:** Along the top of the graph, you will see a toolbar. This contains all the tools you will need to manipulate Signals view. Play, Pause, Zoom, Selection Marquee, Cursors, Setup, Save, and Print &.

3. **Cursors and Cursor Control:** While many tools are self-explanatory, the cursor tool requires a bit more explanation. Click on the Cursor icon in the toolbar. A line with an adjacent box will appear on your graph. This is the cursor and it is used to make measurements. To the right of the toolbar, you will notice two drop down fields. These control your cursor. The field farthest to the right is where you select your channel.

Select Throttle Position from the dropdown. The cursor changes to the same color as the Y-axis that correlates with Throttle Position.

The other dropdown, next to channel selection, is where you decide what value to measure. You can choose to report X values, Y values, both X and Y, or even the difference between a pair of X values or a pair of Y values.

Select the “Value XY” option and note that the box next to the cursor now displays those values.

Well, that is an abbreviated overview of the capabilities of Signal Plot and Signal List view. Hopefully, this exercise has sparked some interest and you are ready to experiment on your own.

---

**Summary**

Decoding signals from messages is a breeze! In this exercise we covered the following topics:

- Creating a message and decoding a signal
- Entering and testing an equation
- Understanding how signals are displayed in the Monitor
- Displaying Signals in the Signal Monitor
Capturing Data with Triggers (Function Blocks)

Overview
There are several ways to capture data in Vehicle Spy 3. In Viewing the Data You Want, you learned how to save the buffer. In this exercise, you will learn how to create a data capture by monitoring data and saving a buffer when a trigger condition is met. You can use several different Function Blocks at the same time.

Part 1 – Create a Data Capture Function Block

To begin, open the Function Blocks view by clicking on Scripting and Automation \ Function Blocks. The view begins as a blank window with a few icons at the top. Click on the [+], then choose Capture to create a Data Capture Function Block.
Function Block Display and Buffer Tab Settings

When you select Capture, a row will appear that represents the Function Block. You can change the name of the function block, and there are controls as well as a Status of the Function Block to the far right.

Below that, a separate window will appear for editing the setup of the Function Block. You will need to adjust the settings using the first four tabs, the fifth tab is used to view the data like the Messages View.

The tabs that control how the Data Capture Function Block captures data are:

- Buffer
- Start
- Stop and Trigger
- Storage

Part 2 – Setting the Buffer Tab

The Buffer tab is used to filter your data capture. The setup is identical to using a Filter Setup. It is not necessary to filter data; leaving this tab as-is will allow the Function Block to capture all data.

Part 3 – Setting the Start Tab

The Start tab is for adjusting when the Function Block starts working, not when to start capturing data. You can choose between:

- **Start Immediately** – starts the Function Block once you start Vehicle Spy.
- **Manual Start** – starts the Function Block on a key press or clicking the gray button in the green Play column. You can choose a Hot Key for manual starting.
- **Use Start Expression** – starts the Function Block when the formula you enter is true. To create an expression, choose this setting and then click the $f(x)$ button for the Expression Wizard.

There's also a useful checkbox to know about: If you check **Automatically Restart When Complete**, the Function Block will automatically restart when it completes saving a block of data.

For most applications, use the Start Immediately setting and check the Automatically Restart When Complete check box. With these settings, the Function Block starts immediately upon running Vehicle Spy, and when a data capture is complete, the Function Block restarts and immediately looks for the next data capture.
Part 4 – Setting the Stop and Trigger Tab

Click on the Stop and Trigger tab. You have four different ways to capture data:

- **Collect in a One-Shot Buffer** – This will collect the number of messages in Buffer Size once and stops. This can be used to Automatically Save once captured.
- **Collect in a Circular Buffer** – This will collect the number of messages you have in Buffer Size in a FIFO buffer, and will constantly overwrite old data. You'll need to use the settings in the Storage tab to make an Expression or manually make the function block save the data in the buffer.
- **Collect Before and After a Trigger Expression** – This collects data up to the message size in a FIFO buffer, and when the Expression is true, continues to save the Post Trigger number of messages (or the messages during the Post Trigger Length of Time setting.) This allows for pre- and post-trigger capture, based on the incoming data. To create an expression, choose this setting and then click the f(x) button for the Expression Wizard.
- **Collect Before and After a Manual Trigger** – The same as Trigger Expression, except it uses a key or mouse click to be the trigger.

![Settings for the Stop and Trigger Tab of the Function Block](image)

Part 5 – Setting the Storage Tab

Click on the Storage tab. There are three ways to store the data once captured.

- To ensure immediate storage of captured data, you should pick **Automatically Save When Complete** in most cases.
- **Manual Save**, which saves on a “Hot Key” you choose or a click of the mouse.
- **Save When Expression Is True**, which evaluates a formula you enter and will save the data when the expression is true. To create an expression, choose this setting and then click the f(x) button for the Expression Wizard.

Note there are several check boxes that control how the data is saved – if you check **Append Time and Date to File Name**, it makes a new file each time the Function Block is activated. If you want your data overwritten, make sure this check box is clear.

![Settings for the Storage Tab of the Function Block](image)
Reverse Engineering

Overview

Reverse engineering is the task of discovering the signals encoded in the raw messages of a vehicle network, without the benefit of a database to decode them. If you do benchmarking, competitive analysis, or you don’t have access to a database for any reason, you will need to use this technique to get the data you need.

The process of reverse engineering is much like being a detective. You get clues from the vehicle network, verify what you know, and get more clues along the way. Here are some strategies to help you find what you’re looking for.

Part 1 – OBD Diagnostics Values

If you are interested in using signals that happen to be one of the US government-regulated On-Board Diagnostics values, we include a database as an example file in Vehicle Spy. These values include emissions-related signals such as O2 Sensors, MAP Sensor, RPM, Speed, and Fuel Pressure. To load the OBD database, click on the File → Login, choose the Examples tab and pick J1979 – HSCAN.

To receive a government-regulated parameter, you must send a request first. One response is sent for each request. J1979 – HSCAN loads these requests in the Transmit Table, and their responses in the Receive Table.

To begin requesting a value, go to Vehicle Networks → Tx Panel, find the value you want in the list, and configure the request to be sent Periodic On/Off. Set the Rate to the rate you’d like to receive the value. Click on the Transmit button, and it will lock on. You will begin receiving the value you request as part of the bus traffic.

Requesting throttle position and RPM @ 100 ms

Part 2 – Using Your Filters

You can use filters to help narrow down the messages you’re examining. For instance, you can narrow down messages by Arbitration/ID numbers by putting the suspected IDs in the filter field at the top of the Arb/ID column. You can also eliminate messages that don’t change by using the Changing filter in the Filter Bar, and using wildcards such as ? and * to filter data bytes.

Part 3 – Using Activity Highlighting

You can narrow down and identify activity on a specific message by Activity Highlighting. This feature automatically highlights data that is changing on the vehicle network.

There are two kinds of activity highlighting: Blue highlights show data that change due to a one-time event, then stops changing. Signals such as door switches and PRNNDL are values that may change once. Gray highlights indicate data that change periodically (often with each updated message.) Signals such as engine RPM and fuel pressure are values that change periodically.
Blue and gray highlighting shown in Data Bytes field

With that information, you can eliminate data that is changing when you know your signal should remain constant. You can also further eliminate data that doesn’t change when you know your signal is changing.

Part 4 – Priority and Update Rates
When looking for messages, keep the priority of the message in mind. Lower Arbitration/ID numbers are usually assigned to values used for real-time control of the vehicle, such as engine controls or ABS controls. They usually update at a faster rate than other messages. This can help you narrow the number of messages that may have the data you need.

Part 5 – Monitoring While Engine is Off
If you’re looking for messages that are not coming from the engine, then you should try monitoring the vehicle bus while the engine is not running. This allows you to narrow down messages that are coming, for instance, from a body controller or other controllers in the passenger compartment.

Part 6 – Decoding Signals from Data Bytes
It is important to note that most messages contain several different signals, one of which is the signal you may be looking for. Each signal may use one or more bits or bytes to describe it. There are several signal types, and knowing about each one will help you identify signals within a message. Once you identify the type of the signal, you can create a signal in your Receive Table that decodes the signal in the proper way (see Decoding Signals From Messages for details on decoding.)

Digital Signals
Data that can be represented by “ON” or “OFF”, “True” or “False” can be called digital signals, and they are often represented by a single bit changing in a message. Examples include a door switch, or a radio button.

To aid you in identifying these types of signals, choose the Binary Format at the bottom of the Messages View. You can then see each bit change within each data byte. Note that the activity highlighting will still highlight the entire byte, but it is easy to see each bit as it changes.

State Encoded and Binary Signals
Data that can be represented by several discrete states can be called State Encoded signals. These are usually represented by two or more bits within a signal. Examples include the transmission (PRNDL); transfer case (2WD, 4WD H, 4WD L); or sunroof switch (Open, Close, Express Open).

The Binary Format can help you view these signals, since they are often represented by two or more bits. For instance, PRNDL could be represented by three bits – Park may be 000, Reverse may be 001, Neutral may be 010, and so on.
ASCII Data
Occasionally signals may represent letters or ASCII characters. The most popular use of ASCII is the VIN number of the vehicle.

If you’re looking for ASCII signals, you will see one byte per letter or number. Hex values will often range between 0x30-0x39 for numbers, 0x41-0x5A for capital letters, and 0x61-7A for lowercase letters—however, any hex value can be ASCII. Clicking on the ASCII Format button will allow you to see the characters immediately.

Analog Data
Signals that are represented by integers for whole number values, or floating point for fractional values. These values can be represented by one or more bytes. Examples of analog data are O2 Sensors, temperature, tire pressure, and most other sensors on the engine.

Use the Decimal Format to identify integers that use one byte easily. Other types of analog will have to be decoded by a signal in the receive table (see Decoding Signals from Messages.)

Make sure to watch for the more significant bits to change more slowly, while the less significant bits will change much more rapidly. These can be flipped around, depending on the design of the hardware.

Conclusion
These tips can help you get a quick start on reverse engineering. Remember that you’re looking for clues to put the puzzle together, so it takes time—especially if you’re reverse engineering many signals or all the messages from a single ECU. Refer to Decoding Signals from Messages for specific settings for your signals.

“Parking Lot” Flashing (Stand-Alone Flashing)

Overview
“Parking Lot” flashing refers to flashing ECUs that are installed in a large fleet of cars. You may have dozens or even hundreds of cars that require new firmware in an ECU. Sometimes, the ECU may be different in each car (i.e.: radios) or there may be several ECUs to flash in each vehicle.

In these cases, you have two choices:

- You can use your laptop and a neoVI to flash each ECU. Usually, this method requires that you manually select the proper firmware and identify the ECU yourself. You connect to the ECU via the ALDL or OBD connector provided in the vehicle to perform the flash.

- Use our Stand-Alone Flash feature. Instead of using a laptop or providing power, you download the flash files and instructions into the neoVI itself. To operate, simply plug it into the ALDL or OBD connector. The neoVI identifies the ECU(s), and flashes the correct firmware to each ECU. This feature is only available in neoVI-RED, neoVI-FIRE and neoVI-YELLOW models with a 2 GB microSD memory card slot on its side, under the rubber boot.

The software tools and processes differs depending on the manufacturer. Generally, there are four steps to the process. Contact Intrepid Control Systems for specific instructions and a training video for your situation.

Part 1 – Preparing Your Flash Files

To flash the ECU, you will need the firmware file for each ECU first. This will be contained in a file generated by the maker of the ECU or the vehicle manufacturer using the ECU. Put these firmware files in the same directory where you will store your flash script.
Part 2 – Writing the Flash Script
With the firmware files prepared, the script to flash the ECU needs to be loaded or created. Once you have the proper software utilities from Intrepid, you can create your own flashing scripts as needed for each project.

Depending on the manufacturer of the ECU, either a standard script is loaded into Vehicle Spy 3, or a separate utility creates the VS3 file. This provides the instructions to the neoVI about the manner in which to flash the ECU(s).

Examples of Stand-Alone Flash Routines:

- Flash Multiple ECUs
- Flash an ECU depending on the model/type (i.e.: radios with difference features)

The routine can be made to flash files depending on its ID (if IDs don’t match, don’t flash.) Multiple copies of firmware for different ECUs can be flashed based on ID. Contact Intrepid Control Systems for the process and scripts needed in your situation.

Part 3 – Downloading the CoreMini File
Once the script has been created and firmware files are prepared, you can download the files to the neoVI. To do this, click on Tools ➔ Utilities ➔ CoreMini Console.

This opens a utility that transforms the Vehicle Spy 3 script into an executable file (called a CoreMini file). This special file runs in the neoVI and allows you to run Vehicle Spy 3 scripts in the neoVI alone.

To create and load the file, make sure your script is loaded and your firmware files are in the same directory as your saved script. Click on Send. The files will be processed and sent into the neoVI.

Part 4 – Using the neoVI Stand-Alone
Once the neoVI has the CoreMini and flash files loaded, unplug the neoVI from the computer. The neoVI is now ready to run the flash routine on its own.

To run the flash program, simply plug the neoVI’s cable into the network connector. The green LED will flash for a few seconds while the neoVI prepares to run the flashing routine. Then the red LED will flash to signify the routine is running.

Keep the neoVI plugged in while the routine is running. Flashing stand-alone is often much faster than using a computer. For instance, a standard OEM radio will flash in about 90 seconds. The neoVI gets its power from the diagnostic connector, so there’s no need for a battery or external power.

Once the flashing is done, unplug it from the connector. Simply move to the next vehicle and plug it in, and it runs the routine all over again. There is no need for any user input or trigger to start or stop the neoVI.

Summary
Using the neoVI as a stand-alone device for flashing pays for itself in just one flashing session. What may have taken several trained engineers several hours to do can now be done quicker, with less interruption from dead batteries and broken adaptors, and you can utilize untrained personnel immediately.

“Parking Lot” flashing varies from situation to situation so make sure to contact Intrepid Control Systems to get the correct scripts and tools for your situation.
“Flight Recording” (Stand-Alone Recording)

Overview

The neoVI can be used to record bus traffic without the need for an attached computer. Using on-board memory to store a recording script and captured data, the neoVI can hold several hours of data on a 2 GB microSD card. For long term recording, data can be filtered to extend recording time. You can also use multiple microSD memory cards, switching to a fresh memory card when full.

NOTE: This feature is only available in neoVI-RED, neoVI-FIRE and neoVI-YELLOW models with a 2 GB microSD memory card slot on its side, under the rubber boot.

Part 1 – Preparing your Memory Card

The neoVI uses standard microSD memory cards for storage. The included memory card is pre-formatted for use with theneoVI.

To format the memory card, insert the microSD card into a USB adaptor and connect it to your computer. Click on Start → All Programs → Vehicle Spy 3 → SD Card Format and run the format utility.

Formatting the card is a two-step process: First, it must be formatted, then two files are copied to the card: An Extract utility for extracting the data, and a data file which in turn holds all the data from the neoVI.

Once you’ve completed these steps, you can close the utility and remove the microSD card from the USB adaptor.
Part 2 – Write Your Data Capture Script

Use the Data Capture Function Block in Vehicle Spy to create a data capture for the data you're looking for. In Vehicle Spy 3, click on Scripting and Automation → Function Blocks, then click on the [+] sign in the upper left of the Function Block view.

In the setup window that appears, there are five tabs. To operate stand-alone in the neoVI, use the following settings:

- **Buffer**: Configure a filter to capture the messages you want, if any. If you leave this alone, the neoVI will capture all traffic.
- **Start**: Choose Start Automatically and check Automatically Restart When Complete.
- **Stop and Trigger**: Choose Collect in a One-Shot Buffer.
- **Storage**: Choose Automatically Save When Complete and check the Append Time and Date to File Name
- **Data**: Provides a window that shows the data being processed by the function block.

Save this by clicking on File → Save before continuing.

Part 3 – Downloading the CoreMini File

Once the script has been created, you can download the script to the neoVI. To do this, click on Tools → Utilities → CoreMini Console.
This opens a utility that transforms the Vehicle Spy 3 script into an executable file (called a CoreMini file). This special file runs in the neoVI and allows you to run Vehicle Spy 3 scripts in the neoVI alone.

To create and load the file, verify your device and your SD card shows in the drop-down lists, then click on Send. The files will be processed and sent into the neoVI. You can tell the script has been loaded successfully by the prompt at the bottom of the window.

### Part 4 – Using the neoVI Stand-Alone

Once the neoVI has the CoreMini file loaded, unplug the neoVI from the computer. The neoVI is now ready to run the flight recording routine on its own.

Connect the neoVI to the diagnostic connector of the vehicle. The neoVI will turn on once it receives power from the vehicle. First, the green indicator will flash for a few seconds, then the red light will begin flashing. The neoVI is now recording.

Once recording is complete, disconnect the neoVI from the vehicle and remove the memory card.

### Part 5 – Extracting Your Data From the microSD Card

After recording data, remove the microSD card from the neoVI and insert it into the USB adaptor. The microSD card will be filled with two data files, one for extracting the data, one that holds all the data collected during the recording.

To extract the data, insert the USB adaptor into your computer’s USB port. Browse to the SD Card and run Extract.EXE.

### Part 6 – Using Multiple Memory Cards

#### Copying the Script to More microSD Cards

To place the script onto additional cards, you cannot copy the script from card-to-card. You must insert each card into the neoVI, download the CoreMini file to each card (see Part 3), and remove the card. The card is now ready for use.

#### Swapping microSD Cards During Recording

Before removing the memory card, make sure to disconnect the neoVI from the vehicle. Removing and inserting cards with the power on and recording may damage the data on the memory card.

Remove the full memory card, insert the fresh card, and plug the neoVI into the vehicle. The neoVI will initialize and start recording in a few seconds.
Summary

Using the neoVI as a stand-alone device for network “flight recording” can capture errors and intermittent problems unattended. Once configured, users need no special training to operate or even switch memory cards. This gives you more options with your precious resources.

Advanced functions such as stand-alone recording may vary depending on your situation. Make sure to contact Intrepid Control Systems to get the correct scripts and tools for your situation.

Application Examples Summary

Congratulations! You have completed all of the Vehicle Spy Application Examples!

Now you have a solid foundation of skills for working with Vehicle Spy.

Intrepid Control Systems, Inc. will be adding to these Application Examples regularly. If you have any suggestions for additional topics, please let us know.

If you are interested in more training, Intrepid offers a complete schedule of training courses for Vehicle Spy as well as other topics such as CAN and LIN. For more information about training, please visit the Training section on our website.

www.intrepidcs.com

Accessing Tutorial Files in Vehicle Spy

For more help, you can quickly access tutorials included with Vehicle Spy by clicking on the examples tab in the Vehicle Spy Logon Screen. These tutorials correspond with the tutorials in the help files and videos on Intrepid’s website. You can locate the tutorial VS3 files in the examples tab of the Vehicle Spy Logon Screen.

Click on the Examples Tab to Access Vehicle Spy Tutorials
Appendix A: Databases

Using a database is a way to decode signals in messages without having to manually enter in all the decoding information. Vehicle Spy includes several options for configuring databases.

Network Databases (DBC, VS3, J1939)

Databases can be loaded by clicking on Setup in the menu bar and then selecting Database. Database view will open. Database view is divided into two main sections. At the top, notice the Current Platform drop-down. A platform is a user specified set of databases. You can create multiple platforms and quickly switch between them as needed. Two buttons sit just to the right of the Current Platform drop down. The first is "Update Changes". Press this button to update any changes you have made in Databases view. The second button "Setup Platforms" is the button you use to create platforms. Press this button and a dialog will open where you can enter in new platforms or delete ones you no longer need.

Just below the Current Platform section, notice three tabs - Network Databases, UEF Support, and Diagnostics. Descriptions of each tab follow below.

Network Databases Tab

On the left side of the Network Databases tab is a list of possible networks. Add additional networks by clicking "Add" just above the list. Rename or Delete networks by using the button at the bottom of the list. When you click on a network in the list, the right half of the tab switches to setup fields for that network. The first field is for displaying selected DBC and VS3 Databases for that network. (The *.VS3 type of database is a Vehicle Spy 3 setup file. It uses the Receive message table from another setup file as a database.) Press the "Add" button at the far right and choose the desired database type from the popup menu. After you choose the type, a dialog will open allowing you to choose the file from its location on your computer. The figure below shows the Networks view. To add a database for a network, double click on
the cell under "Database" for the network to use. A dialog will appear letting you choose which *.DBC or *.VS3 file to use.

The second field is for specifying a LIN LDF Database file. This field is optional. Click the "Browse..." button to select the file from its location on your computer. Press "Clear" to remove the file. Press the "View" button to open the LDF Tool to setup LIN capabilities.

The third field is for setting the Network UEF Database name. This field is optional as well.

The last field in the Network Databases tab is for selecting a Simulation Setup File. Press the "Browse..." button to open the file from its location on your computer.

**UEF Support Tab**

The UEF Support tab is where you select the Vehicle UEF Database file. This setting is optional. Press "Browse..." to select the file. Press "Clear" to remove a file.

**Diagnostics Tab**

The Diagnostics tab is where you can specify a Vehicle Spy diagnostic database. These files have a .gmd extension. This database holds information on DIDs, PIDs, DPIDs, CPIDs, IDs, LIDs, and memory addresses. Information in this database is used for Snapshot and the Diagnostic Setup view in Vehicle Spy. Press "Browse..." to select an existing file. Press "Create New..." to make a new file. Press "Clear" to remove a file.
DTC Database Tab

DTC information is stored in a separate database in Vehicle Spy. The DTC Database is simply a text file that lists the DTC number followed by the description of the problem. For an example, see the short list below. Once all the entries are made, save the file with a *.TXT extension in the DTC folder located in the Vehicle Spy 3 directory.

B0123, Loss of Serial Data
B0124, Start Switch Circuit Fail

Appendix B: Requesting and Saving DTC Data

Overview

This example will teach you how to use Diagnostic Job services with Function Blocks and Graphical Panels. The end result will be a button on a graphical panel that, when pressed, will request Diagnostic Trouble Codes and save them to a file. A finished copy of this example can be found in the Examples tab of the Vehicle Spy Logon screen.

To achieve this goal, Appendix B will guide you through the following steps:

1. Creating a DTC Job Service
2. Creating a Function Block to request information and save data
3. Making a Graphical Panel for an end user
4. Retrieving and viewing logged data
Part 1 - Creating a Diagnostic Job Service

Make a diagnostic job to request trouble codes.

1. Open Vehicle Spy and log on by selecting your Logon name. For this example, logging on is very important. The data collected will be saved in a data directory titled with the selected Logon name.

2. The next step is to create a Diagnostic Job to read DTCs. Open the Diagnostic Job Editor. Click on Vehicle Networks->Diagnostic Job Setup. Click on “Add" and select GMLAN->$A9 Check Codes Job.

3. For the purpose of this example, we will work with the default settings. By default, we will request DTCs from all functioning ECU’s on the High Speed CAN network of a GMLAN vehicle. In the Job Description field change the description to "Request DTCs from all nodes". Your setup should look like the figure below.

![Setup of a Diagnostic Job](image)

Part 2 - Function block to Request and Save Data

1. The next step is to create a Function block to control the diagnostic service and save the data. Open Function Blocks view. Click on Scripting and Automation in the menu bar and then Function Blocks.

2. Click the + and select "Script". This will create a new Function Block. Change the description of the Function block to something more descriptive like "Check Codes and Log Them to a File".

3. Now we need to enter a script. We will need 4 steps to complete our task. The required steps, along with a description of what they do, can be found in the table below. For the "Diag Job Action" double clicking on the "Value" cell will let you select the diagnostic job to act on and how to act on it. For more information on this command see the electronic help documentation for the Diag Job Action command. Go ahead and enter the steps below to build your script type function block.

<table>
<thead>
<tr>
<th>Step</th>
<th>Command</th>
<th>Value for Step</th>
<th>Reason for Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Diag Job Action</td>
<td>Start Request DTCs from all nodes</td>
<td>Starts, or launches, the diagnostic service.</td>
</tr>
<tr>
<td>2</td>
<td>Diag Job Action</td>
<td>Wait until Complete Request DTCs from all nodes</td>
<td>Waits at that step until the selected diagnostic service is finished. When it is complete, the next function block step is run.</td>
</tr>
<tr>
<td>3</td>
<td>Diag Job Action</td>
<td>Save Request DTCs from all nodes</td>
<td>Saves the received data and message traffic to a log file.</td>
</tr>
<tr>
<td>4</td>
<td>Stop</td>
<td>n/a</td>
<td>Ends the function block</td>
</tr>
</tbody>
</table>
4. To finish our function block setup, we must instruct Vehicle Spy how to start this function block. Click on the Start Tab and select “Manual Start”. The “Manual Start” option makes it possible for the function block to be controlled by a Graphical Panel.

Part 3 - Making a Graphical Panel

1. Open Graphical Panels view by clicking on Measurement and then Graphical Panels. Graphical Panel creation is your chance to be creative. There is no right or wrong way to design a graphical panel.

2. For this Graphical Panel we need 3 controls. The first is a "Function Block Button" to start the function block. The essential properties to set up are:

   FunctionBlock: Check Codes and Log Them to a File
   FBlockAction: 0-Start

   The settings above will cause the button to start the function block every time the button is clicked. Feel free to experiment with other properties (color, size, etc.) to customize your layout.

   Next we will add a LED to let the user know that the code request is still in progress. Add a LED and set the following properties:

   Signal: Select the Diagnostic Job created under "Jobs" with the "Is Running" Property

   Lastly, add a Text Display to display some text that explains what the button does. Text entered in the Caption field will be visible on your panel. The figure below shows an example Graphical Panel.
Part 4 - Finding and Viewing the Data

1. To use this example, connect the attached hardware to a vehicle or ECU and start Vehicle Spy. Click the button on the graphical panel to start the function block that was created. The LED should change color. When it changes back, the collected data is saved to a file.

2. Now that data is collected, where is it? Clicking on the Data button in the upper right will open Windows Explorer to the data folder that corresponds with the selected Log On name. The file name will be the name of the diagnostic service followed by the date and time. An example would be "Request DTCs from all nodes 9-04-2009 3-18-00 pm.csv". Excel or other spreadsheet editors will open this type of file.

Summary

This example shows how to tie different parts of Vehicle Spy together to automate tasks. Using Function blocks, simple scripts can be created to perform common tasks. Graphical panels can then be used to control the function blocks and display testing status and/or the data acquired. Function blocks and graphical panels can be as complicated or as simple as you want to make them. The key is that they perform the desired task.

Appendix C: GMLAN Diagnostics

Overview

This appendix explains how some diagnostic services can work together to expand their functionality.

The scenarios that will be covered in this example are:
- Write DID from Read DID
- Read DPID created with Dynamic DPID

This section assumes that the user has completed the previous Application Examples and has some basic knowledge of GMLAN Diagnostics. A vehicle or bench will be helpful but is not necessary. The important things to understand are the concepts presented.
Part 1 - Read DID Setup

In this example, DID information acquired from Read DID will be passed on to a Write DID service. A possible use for this could be Reading a VIN number, programming an ECU, and then writing the VIN number back to the ECU.

1. Open Vehicle Spy and Log on.

2. Create the Diagnostic Job for Read DID ($1A). Open the Diagnostic Job Editor, Vehicle Networks->Diagnostic Setup. Click on Add and select GMLAN->$1A - Read DID Job.

3. Next, setup the Read DID service. In this exercise we will use the VIN number as an example. If you are connected to a vehicle or a bench where you have access to a DID you can read and write, use this. If you are just following along, this example will be setup for a VIN read. Select an ECU to physically address (and network if not chosen from a database) and the DID number. For the VIN select DID $90.

Part 2 - Write DID Setup

1. Now it is time to setup a write DID service ($3B). Click on “Add” and select GMLAN->$3B Write DID Job.

2. The next step is to setup the Write DID service. Again, the VIN number will be used as an example. If you are connected to a vehicle or a bench, use the same DID that you setup for the Read DID. Select an ECU to physically address (and network if not chosen from a database) and the DID number. For the VIN select DID $90.

3. The last thing to setup is the link between the Write DID service and the Read DID service. Just below the DID number selection field, notice the drop down menu where you can select the data to be written. Select “Enter From Read DID”. Then select the Read DID you set up in Part 1 from the dropdown that appears. For this example there should only be one service to choose from.
Part 3 - Writing the Read DID

1. From the Diagnostic Job Launcher (Vehicle Networks → Diagnostics), run the Read DID service. Run the service by pressing the gray button to the right of the service name.

   If you are connected to hardware and to a bench or vehicle, you should receive the requested data.

2. Now run the Write DID service. The service will write the VIN (or other selected DID) that was read from Read DID to the ECU.

   This exercise shows one simple example. A different ECU could have been selected for the Write DID service. Another variation of this example could include a DPS programming action in between the Read DID and Write DID. This way when the programming is complete, the VIN and other parameters can be put back in the ECU.

Success VIN = 123456789@ABCDEFG

**Positive response from a Write DID**

Part 4 - Requesting PIDs from a Dynamic DPID

In this section, you will learn to use Dynamic DPIDs to request PIDs through a Request DPID service ($AA).

1. Just like before, this example will work with hardware. Even if hardware is not available, carefully reading through the exercise will help with understanding the overall procedure. The first step is to make sure PID information is entered in for the ECU from which data is to be requested. This information is entered in under Vehicle Networks→ECU.

2. Select the ECU, click on the PID tab, and enter in the PID data. For more information review the ECUs view topic in the electronic help documentation.

   Next, create the Dynamic DPID to request the PID data. Under Diagnostic setup (Vehicle Networks→Diagnostic Setup) add a "$2C Dynamically Define DPID" job. Select the ECU and the Network Type and then select the PID's that you created under the ECU's view.

   ![Example Dynamic DPID ($2C) Setup](image)
Part 5 - Requesting the Dynamic DPID

1. The final step is to request the DPID. Using the “Read Data By Packet Identifier service ($AA)” this data can be accessed. In “Diagnostic Setup add a Read Data By Packet Identifier service ($AA”). Next setup the ECU ID and the network. Keep the sub-function set to Send One Response. To link the Dynamic DPID to the Read DPID service, click on the “Dynamic...” button and select the Dynamic DPID service setup in the previous step.

1. With setup completed, open the Diagnostic Job Launcher. Launch the Dynamic DPID service. If a positive response is received, run the Read DPID service. The requested data from the PIDs should be displayed and decoded using the Diagnostic Database decoding that was setup under ECUs view.

Conclusion

This example describes how Diagnostic services can be linked together to accomplish different tasks. Function blocks can be used to automate the task of sending different services and reacting to the responses returned.
Appendix D: ECU Flashing with Manufacturer Software

Overview
This section covers how to use selected vehicle manufacturer's software with your neoVI and Vehicle Spy 3 to flash ECUs. If your manufacturer or OEM software is not listed, contact Intrepid Control Systems for details on how to flash an ECU for your situation.

RP1210 Support
Our hardware supports the RP1210 standard. Therefore, most OEM diagnostic and service programs can use our hardware directly. Check your software to ensure it is RP1210 compliant before use.

Install the Vehicle Spy 3 software to install the RP1210 drivers for your hardware. Once installed, connect your neoVI and run your diagnostic/service software. Follow the OEM software's instructions for flashing and other maintenance functions.

Ford’s DET and the DLL Switcher
Ford’s Diagnostic Engineering Tool can access your neoVI directly, when used in conjunction with Intrepid’s DLL Switcher. The DLL Switcher is a program that identifies Vector DLL files used by the DET program and swaps the DLLs with Intrepid DLLs. This swap allows the DET to use Intrepid neoVIs in place of Vector Hardware. The DLL Switch tracks swapped DLLs and allow you to revert the DLLs if you like.

Step 1 – Locating the DLL Switch Program
The DLL Switch is installed with the Vehicle Spy 3 software, and is found in the Start → All Programs → IntrepidCS group. Click on ICS DLL Switch to run the program.
Step 2 – Using the DLL Switch Program

There are two different DLL files that may be used by Ford's Diagnostic Engineering Tool:

**vxlapi.dll**: Located in the `\Windows\System32` directory only.
**vcand32.dll**: Can be located anywhere on the hard drive.

Click on the Search button to begin a search for the vcand32.dll file. This may take a while; the entire hard drive will be searched.

When it’s done searching, each instance of the DLLs will be shown with a check mark next to each one. Check the ones you’d like to replace with Intrepid’s DLL and click the Replace button.

[Image: DLL Switch Program, showing located DLL files.]

---

Step 3 – Configuring Ford DET Software

To operate the Diagnostic Engineering Tool, simply select the “Intrepid with DLL Switch” choice for your hardware. You can now flash and operate all the DET functions using your neoVI.

---

Step 4 – Reverting to the Old DLLs

To switch the DLLs back, simply run the DLL Switch program again. You may need to click on Search again to find the DLLs again.

To revert them back to their original state, click the check boxes for the DLLs you want to switch, and click on the Revert button. This will return the proper version of DLL to its original place.
Appendix E: GM’s DPS Programming Automation

Overview of GM DPS with Vehicle Spy 3

Vehicle Spy 3 can access GM’s DPS directly which allows additional functions and features in Vehicle Spy 3 itself.

This example will show how to use Diagnostic Job services along with Function Blocks and Graphical Panels to program ECU’s using GM’s DPS application. The end result will be a button on a graphical panel that will flash 2 archive files, one right after the other. This exercise uses the same basic steps as Appendix B, the only real difference is the diagnostic service used. A finished copy of this example can be found in the Examples tab of the Vehicle Spy Logon.

To achieve this goal, this section will guide you through the following steps:

1. Creating 2 DPS Programming Job Services
2. Creating a Function Block to launch the services
3. Making a Graphical Panel for the end user
4. Using what was created
Part 1 - Creating a DPS Diagnostic Job Service

1. Open Vehicle Spy and Log On

2. The next step is to create the Diagnostic Job for DPS. Open the Diagnostic Job Editor, Vehicle Networks → Diagnostic Setup. Click on Add and select GMLAN → DPS Programming.

3. First, we will setup the Job Description. In this example, we will setup multiple DPS programming services so it is a good idea to customize the title in the Job Descriptions field. Change “DPS Programming” (the default description) to something more specific such as “DW CAN ECU”. The other important things to setup in the Basics tab, as seen in the figure below, are the selecting the DPS archive file to program and the Diagnostic Pins to program on.

4. The “J5234 DLL Options” tab, below, has options for configuring J2534 communication. Normally, the defaults are acceptable.

5. The “Setup” tab is where DPS.exe is located. If DPS is installed in a different directory, click Browse and select the proper location.
6. Add a second DPS Programming service for a second ECU to program. If you are following along with the finished example, change the DPS archive file to a valid archive file for both Diagnostic Jobs.

Part 2 - Function Block to Launch Programming Services

1. The next step is to create a Function block to control the diagnostic services we set up. Function blocks are created in Function Blocks view which is found under Scripting and Automation in the menu bar.

2. Click the + and select "Script". This will create a new Function Block. Enter a specific description for the Function block such as "Program ECUs".

3. Next, we will write the script. For this task, we will need to enter 6 steps. See the table below for the specifics of each. For the "Diag Job Action" double clicking on the "Value" cell will let you select the diagnostic job to act on and how to act on it. For more information on this command see the electronic help documentation for the Diag Job Action command.

<table>
<thead>
<tr>
<th>Step</th>
<th>Command</th>
<th>Value for Step</th>
<th>Reason for Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Diag Job Action</td>
<td>Start DW CAN ECU</td>
<td>Starts, or launches, the diagnostic service.</td>
</tr>
<tr>
<td>2</td>
<td>Diag Job Action</td>
<td>Wait until Complete DW CAN ECU</td>
<td>Waits at that step until the selected diagnostic service is finished. When it is complete, the next function block step is run.</td>
</tr>
<tr>
<td>3</td>
<td>Wait For</td>
<td>5.000 Sec</td>
<td>Waits for 5 seconds. This is not needed but puts a delay so script progress can be monitored by user</td>
</tr>
<tr>
<td>4</td>
<td>Diag Job Action</td>
<td>Start SW CAN ECU</td>
<td>Starts, or launches, the diagnostic Service</td>
</tr>
<tr>
<td>5</td>
<td>Diag Job Action</td>
<td>Wait until Complete SW CAN ECU</td>
<td>Waits at that step until the selected diagnostic service is finished. When it is complete, the next function block step is run.</td>
</tr>
<tr>
<td>6</td>
<td>Stop</td>
<td>n/a</td>
<td>Ends the function block</td>
</tr>
</tbody>
</table>
4. To finish our function block setup, we must instruct Vehicle Spy how to start this function block. Click on the Start Tab and select “Manual Start”. The “Manual Start” option makes it possible for the function block to be controlled by a Graphical Panel.

Part 3 - Making a Graphical Panel

1. Open the Graphical Panel editor (Measurement → Graphical Panel).

2. For this Graphical Panel we need 7 controls. Some of the controls will be repeated, one for each ECU. The first is a “Function Block Button” to start the function block. The essential properties to set up are:

   FunctionBlock: Program ECU
   FBlockAction: 0-Start

   The remaining Controls are listed and described below:

   Text Display Signal: Select Jobs, select "Log" and "Value" property for the first service. (Make sure "Evaluate as text" is selected)

   Text Display Signal: Select Jobs, select "Log" and "Value" property for the second service. (Make sure "Evaluate as text" is selected)

   Bargraph Signal: Select Jobs, select "Percent" and "Value" property for the first service.
   Min: 0
   Bargraph Signal: Select Jobs, select "Percent" and "Value" property for the second service.
   Min: 0

   LED Signal: Select Jobs, select the first service and the "Is Successful" property.

   LED Signal: Select Jobs, select the second service and the "Is Successful" property.
With this setup, when the function block button is clicked, the DPS programming jobs will start. The text display will give the current text from the log. The bar graph will display the progress of the programming and the LED will turn on when the programming is complete.

Part 4 - Using What You Have Created

1. To use this example, connect the attached hardware to a vehicle or to the ECUs to program and start Vehicle Spy. Click the button on the graphical panel to start the function block that was created. A few windows from DPS may pop up on the screen. Vehicle Spy will take care of these screens and close them when it is done with them. The graphical panel components added should display the progress and log information from the programming. When the first ECU is done, the second one will start programming.
LICENSE AGREEMENT FOR INTREPID CONTROL SYSTEMS SOFTWARE

TERMS and CONDITIONS

This is a legal agreement between you (either as an individual or an entity), the user, and Intrepid Control Systems, Inc. If you do not agree to the terms set forth in this License Agreement, you must not install the software. By installing this software, you have signified your acceptance of the terms and conditions of this software. If you are unwilling to accept the terms of this Agreement, return the software immediately for a refund.

DEFINITIONS

Affiliate: A legal entity which is controlled by, or controls, or is under common control with Licensee. Control means (i) direct or beneficial ownership of at least fifty percent (50%) of the voting securities of a corporation or other business organization with voting securities, or (ii) direct or beneficial interest in a fifty percent (50%) or greater interest in the profits and capital of a partnership or other business organization without voting securities.

Distribution: The distribution on physical media and/or electronic distribution.

Documentation: The user guides and instructional material, if any, accompanying delivery of a Program may be updated from time to time. Documentation may be delivered in printed and/or online forms, and in one or more languages.

Internal Operations: The use of a Program by employees of Licensee or an Affiliate for the purpose of performing services on behalf of the Licensee or Affiliate, or in the performance of services for Third Parties who engage Licensee or an Affiliate for such services. As used herein, “employees” includes but is not limited to student interns and consultants of Licensee or its Affiliates performing work at the Licensee facilities.

License: Intrepid Control Systems grants to Licensee of a nonexclusive right to install and use a Program in accordance with the License Option purchased.

License Administrator: Is an appointed contact person or an appointed department (typically IT or tools support department) at the Licensee facility, responsible for the distribution, and maintenance of the said software Programs. The License Administrator is also responsible to ensure that all persons permitted to have access to the Programs comply with the terms and conditions of this software license agreement.

Licensed Users: Those users of the Programs, designated by the Licensee as authorized to use the Programs for Licensee's Internal Operations, to the extent permitted by the License Option purchased.

Licensee: The individual or entity to whom Intrepid Control Systems grants the License. The Licensee is responsible for meeting the contractual obligations of the License, and ensuring that anyone permitted access to the Programs also meets such obligations.

License Option: The specific rights, restrictions, and obligations under which Licensee may install and use a Program pursuant to this Agreement, including the License Option selected. By accepting a Program during the Acceptance Period, Licensee also accepts the applicable rights and agrees to be bound by the applicable obligations and restrictions of the License Option purchased.

Licensed Users: Those users of the Programs, designated by the Licensee as authorized to use the Programs for Licensee's Internal Operations, to the extent permitted by the License Option purchased.

Licensor: The person who, or entity which, grants a license to Intrepid Control Systems to redistribute that person's or entity intellectual property.

Program(s): The computer software delivered hereunder, including enhancements and error corrections. Each product from Intrepid Control Systems is a separate Program.

Third Party: Any person or legal entity that is not the Licensee or an Affiliate.

Hardware-Key: Any purchased Intrepid Control System hardware that contains a serial number and stored license capable of unlocking Intrepid Control System Software.

INSTALLATION AND USE

Specific rights, obligations, and restrictions apply to each License Option. Licensee right to install and use the Programs is determined by the License Option selected, including the permitted Installation Type(s) with respect to such License Option. By accepting the terms and conditions of the Agreement, Licensee also accepts the License Option purchased.

LICENSE TERMS

Without prior written consent from Intrepid Control Systems, the Licensee of the Software may use the Software ONLY with hardware provided by Intrepid Control Systems.

This License is effective as of the time you receive the Intrepid Control Systems Software and will continue until you cease all use of the Intrepid Control Systems Software and return or destroy all copies thereof, or until it is automatically terminated upon your failure to comply with the terms of this License.

Licensee shall not provide access to the Programs via a Web application without procuring specific rights to do so by Intrepid Control Systems.

Licensee shall not provide multi-user access to the Programs by calling the Programs as a server from other programs without procuring specific rights to do so by Intrepid Control Systems.

Licensee may make backup copies of the Programs as necessary to support the use of the Programs in accordance with this Agreement. Licensee may not remove any copyright, trademark, proprietary rights, disclaimer or warning notice included on or embedded in any part of the Programs. All copies of Programs shall contain all copyright and Proprietary notices as in the original.

Licensee shall not decompile, disassemble or otherwise reverse engineer the Programs.

Licensee shall not copy the written materials accompanying the Intrepid Control Systems Software. In addition, you may not rent, lease or alter the Intrepid Control Systems Software or any portion thereof without written consent from Intrepid Control Systems; but you may transfer your rights under this License Agreement on a permanent basis provided you transfer this License Agreement, the Intrepid Control Systems Software and all accompanying written materials and retain no copies, and the recipient agrees to the terms of this License Agreement.

The Intrepid Control Systems Software product is licensed as a single product. Its component parts may not be separated for use on more than one computer.
LICENSE OPTIONS

Floating License (Hardware-Key): Licensee may elect to install the Programs on multiple computers and insert the purchased Intrepid Control Systems Hardware containing a Hardware-Key to activate the installed Program. Floating Licenses may not be used by any individuals who are not direct employees of the Licensee. Use by consultants and temporary employees working outside of the Licensee facilities is prohibited. The License Administrator is responsible for ensuring that all persons permitted to have access to the Floating License programs comply with the terms and conditions of this software license agreement.

In the event a Floating License Hardware-Key becomes non-functional due to a manufacturing or software defect, the device is to be returned within the ninety (90) days warranty period to Intrepid Control Systems for free replacement. Should the device become non-functional due to damage, a new device is to be purchased at the original cost of Hardware-Key. Should a Hardware-Key become lost, a new Program must be purchased at the then current list price of the Product.

CPU License for the Windows platform only: Licensee may elect to install the Programs on a single designated computer, provided the Programs are only operated from that designated computer console by a single person at any given time (a "Designated CPU Installation Type"). This Designated CPU Installation Type is intended to accommodate a single Windows computer shared by multiple users.

In the event that the Licensee CPU License becomes disabled or is replaced, the license may be transferred to another computer provided that the Licensee signs a written license transfer agreement supplied by Intrepid Control Systems. Licensee must contact their Intrepid Control Systems sales representative should this be necessary. Intrepid Control Systems reserves the right to limit the number of times a license may be transferred.

LIMITED WARRANTY

Intrepid Control Systems, Inc. warrants that the Intrepid Control Systems Software will perform substantially in accordance with the accompanying written materials for a period of ninety (90) days from the date of receipt. Any implied warranties on the Intrepid Control Systems Software are limited to ninety (90) days.

CUSTOMER REMEDIES

Intrepid Control Systems, Inc.’s entire liability and your exclusive remedy shall be, at Intrepid Control Systems, Inc.’s option, either (a) return of the price paid or (b) repair or replacement of the Intrepid Control Systems Software that does not meet Intrepid Control Systems, Inc.’s Limited Warranty and that is returned to Intrepid Control Systems, Inc. with a copy of your receipt. This Limited Warranty is void if failure of the Intrepid Control Systems Software has resulted from accident, abuse or misapplication. Any replacement Intrepid Control Systems Software will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer. Neither these remedies nor any product support services offered by Intrepid Control Systems, Inc. are available for the US/Canada version of this product (as indicated on the disk label) if purchased or used outside of the United States of America and Canada.

NO OTHER WARRANTIES

Intrepid Control Systems, Inc. disclaims all other warranties, either express or implied, including but not limited to implied warranties of merchantability and fitness for a particular purpose, with respect to the Intrepid Control Systems Software, the accompanying written materials and any accompanying hardware.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES

In no event shall Intrepid Control Systems, Inc. be liable for any damages whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss of business information or other pecuniary loss) arising out of the use or inability to use this Intrepid Control Systems, Inc. product, even if Intrepid Control Systems, Inc. has been advised of the possibility of such damages.

The above terms constitute the entire agreement between you and Intrepid Control Systems, Inc. with regard to the Intrepid Control Systems Software, and such agreement may not be modified except in writing and signed by both parties. If any provision of this agreement is held to be invalid by any court of competent jurisdiction, it is to that extent deemed omitted and the remaining provisions will continue in full force and effect. This agreement will be construed and enforced in accordance with Michigan law, excluding its principles of conflict of laws.

UNITED STATES GOVERNMENTAL ENTITY USERS

This paragraph shall supersede the provisions of the License Agreement in the event of a conflict.

The Intrepid Control Systems Software and documentation are sold only with “Restricted Rights.” Use, duplication or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1)&(2) of the “Commercial Computer Software–Restricted Rights” at 48 CFR 52.227-19, if applicable. The contractor is Intrepid Control Systems, Inc. 5700 18 Mile Road, Sterling Heights, MI 48314.
Getting started with Vehicle Spy is quick and easy thanks to Vehicle Spy Help Documentation and Application Examples. Simply review the examples in this book that best fit your application and you will be up and running in no time.